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Resumen 

En el presente proyecto se desarrolló el modelado de un filtro empaquetado con esferas 

de borosilicato para el tratamiento de aguas residuales mediante Dinámica de Fluidos 

Computacional (CFD). Se desarrolló la geometría modelo del sistema con ayuda del 

software INVENTOR de AutoCAD, esta herramienta permitió construir el filtro al igual 

que el empaquetamiento de esferas en su interior. El filtro consistió en: un codo de 90° 

de 1/2‘’, un retenedor de sólidos de 11 [mm] de largo, una columna de 152.4[mm] de 

largo y diámetro interno 11[mm], esferas de 3.5 [mm] de diámetro, y un reductor de 1/2‘’ 

a 1/4’’. Una vez obtenida la geometría, se la importó al software COMSOL Multiphysics 

® para llevar a cabo dos estudios dinámicos dentro del sistema. El primer estudio 

realizado consistió en describir el comportamiento del fluido dentro de la columna, 

considerando un modelo de flujo turbulento. Para ello se utilizó el módulo de Fluid Flow, 

con la interface de flujo turbulento Turbulent Flow k-ω. El segundo estudio permitió 

cuantificar la eficiencia de filtrado en base a la retención de partículas de un contaminante 

genérico de distintos tamaños en el filtro. Para este caso se empleó el modelo Particle 

Tracing for fluid Flow, con lo cual se cuantificó el porcentaje de partículas retenidas en 

un intervalo de tiempo. Finalmente realizados los estudios se obtuvieron los perfiles de 

presión, velocidad y la efectividad de filtrado del sistema. 

 

Palabras Clave: Filtro, Dinámica de Fluidos Computacional (CFD), Turbulent Flow k- 

ω, Particle Tracing for Fluid Flow, perfiles de velocidad y presión, efectividad de 

filtrado. 
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Abstract 

A borosilicate filtration system packed with glass beads was modeled and simulated using 

Computational Fluid Dynamics (CFD) for water treatment applications. The geometrical 

model representation of the system was constructed in INVENTOR of AutoCAD. The 

filter consisted of: a 90 ° elbow of 1/2", a solid retainer of 11 [mm] long, a column 152.4 

[mm] long and internal diameter 11 [mm], spheres of 3.5 [ mm] in diameter, and a 1/2 "to 

1/4" reducer. Once the geometry was obtained, it was imported to COMSOL Multiphysics 

® software to carry out two dynamic studies within the column. The first study consisted 

in describe the behavior of the fluid inside the system, considering a turbulent model. For 

this, the Fluid Flow module was used, with the turbulent flow interface Turbulent Flow 

k-ω. The second study allowed quantification of the filtration efficiency based on the 

retention of particles of a generic contaminant with varied sizes in the filter. For this case, 

the Particle Trace for Fluid Flow model was used, which quantified the percentage of 

particles retained in a time interval. Finally, profiles of pressure, velocity and the filtering 

effectiveness of the system were obtained. 

 

Keywords: Filter, Computational Fluid Dynamics (CFD), Turbulent Flow k- ω, Particle 

Trace for Fluid Flow, velocity and pressure profiles, filtering effectiveness. 
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1. Introducción 
 

Alrededor de 225.000 toneladas de residuos sólidos son producidos diariamente por un 

aproximado de 300 millones de habitantes latinoamericanos (K. Reynolds, 2002). 

Lamentablemente de esta cantidad exorbitante de contaminación, menos del 5% de las 

aguas servidas son tratadas en las ciudades latinoamericanas (K. Reynolds, 2002). La falta 

de procesamiento del agua y su exposición al medio ambiente tanto en zonas urbanas 

como rurales causa serios riesgos de enfermedades y contaminación. Entendiéndose 

como contaminación no simplemente a las aguas servidas, sino en el suelo y fuentes 

acuíferas subterráneas. Dentro de este contexto es preciso definir al término saneamiento, 

ya que se empleará con frecuencia más adelante. Por saneamiento se entiende a las 

instalaciones y servicios que permiten eliminar sin riesgo los desechos producidos por el 

ser humano (orina y heces) (OMS/UNICEF, 2015).  

En Ecuador, se proyecta que tomará 10 años alcanzar una cobertura de saneamiento 

universal en el país en base al último censo realizado por la Secretaría de Aguas en el 

2014 (SENAGUA, 2012). La Tabla 1 presenta el porcentaje de agua potable y 

saneamiento en cada una de las zonas del país, definiéndose como:  

 Zona Grande: mayor a 300.000 habitantes 

 Zona Mediana: Entre 50.000 y 300.000 habitantes 

 Zona Pequeña: Entre 15.000 y 50.000 habitantes 

 Zona Micros: Menor a 15.000 habitantes 

Es preciso mencionar en términos generales que el saneamiento en el Ecuador ha 

presentado un incremento en los últimos años, sin embargo, aún existen zonas como: 

región rural amazónica y la región rural de la costa en donde el saneamiento es precario. 

Por ende, la acumulación de aguas servidas es mayor al igual que el índice de 

enfermedades y contaminación.  

Uno de los problemas que presentan las aguas residuales es su alto contenido de 

microorganismos patógenos en forma de bacterias o virus. Estos organismos ocasionan 

enfermedades que sin el seguimiento médico respectivo pueden ser mortales. Entre las 

enfermedades más conocidas acusadas por la ingesta de aguas negras se pueden 

mencionar: la gastroenteritis, el cólera, la hepatitis, etc (K. Reynolds, 2002). Siendo la 

segunda una de las enfermedades que presenta mayor índice de mortalidad. A partir del 

periodo de 1991 al 2011 en Latinoamérica se registraron 1.839.037 casos de cólera, con 

19.538 muertes y una letalidad de 1.06% (Harvez & Avila, 2013). En la Figura 1 se 
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observa la tasa de mortalidad en los distintos años por cólera, desde 1991 hasta el 2011 

en Latinoamérica. 

 

Tabla 1. Porcentajes de cobertura de agua y saneamiento en el Ecuador. FUENTE (SENAGUA, 2012) 

 

 

 

Figura  1. Índices de mortalidad por cólera desde 1991 hasta 2011 en Latinoamérica. FUENTE (Harvez & Avila, 

2013)  
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Según Harvez y Ávila (Harvez & Avila, 2013), las tasas de mortalidad infantil y el índice 

de desarrollo humano (IDH) se relacionan con la propagación de la cólera, la cual ha sido 

mayor en los países con tasas de mortalidad infantil altas (> 40 por 1000 nacidos vivos), 

como: Bolivia, Perú, Brasil, Nicaragua, Guatemala, Ecuador y El Salvador (Harvez & 

Avila, 2013). El agua y alimentos contaminados fueron la causa principal de mortalidad 

infantil en los países recién mencionados. Problema que a su vez está asociado a  los 

precarios sistemas sanitarios y elevados niveles de pobreza (Harvez & Avila, 2013). Los 

países con un IDH menor a 0,720 (Perú, Nicaragua, Guatemala, Bolivia, El Salvador y 

Honduras) presentaron incidencias de cólera mayores. La relación inversa se vio en países 

con un IDH mayor a 0,850, un producto interno bruto (PIB) per cápita superior a los US$ 

2000 y una tasa de alfabetización femenina mayor de 90%, como Argentina, Chile y Costa 

Rica, donde se presentaron las más bajas incidencias de cólera en Latinoamérica (Harvez 

& Avila, 2013). 

A partir de lo mencionado, se observa que si bien un alto índice de desarrollo humano 

(IDH), tasas de alfabetización y un elevado producto interno bruto (PIB) determinan 

condiciones favorables para impedir epidemias de cólera. Las aguas contaminadas y las 

deficiencias en los servicios sanitarios son la razón primordial para una mayor incidencia 

de mortalidad por cólera y tasas de mortalidad infantil. Por ende, es preciso tomar 

acciones en búsqueda del desarrollo de tratamientos de aguas servidas para reducir estos 

índices en Latinoamérica. 

 

Entre las diferentes formas de tratamiento de aguas negras se encuentran el uso de filtros 

para disminuir el número contaminantes y microorganismos patógenos presentes en las 

aguas servidas. En breve, la función de un filtro radica en atrapar la mayor cantidad de 

partículas contaminantes en su interior, disminuyendo su concentración en las aguas 

servidas. Una de las técnicas más utilizadas es la filtración granular con medio poroso. El 

cual consiste en un proceso de separación sólido-fluido aplicado para la remoción de 

ciertas partículas presentes en varios tipos de fluidos (Ramarao, 2007). Una característica 

importante del filtrado granular es que debido a la relativa abundancia de la sustancia 

granular, la cual es resistente a la temperatura y corrosión; se favorece el tratamiento de 

corrientes a altas temperaturas y con compuestos corrosivos (Ramarao, 2007).  

Debido al efecto de deposición de las partículas en el medio poroso la porosidad 

disminuye con lo cual la estructura del medio filtrante varia significativamente. Esto a su 
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vez produce la caída de la presión que es compensada manteniendo una alimentación 

constante del fluido a tratar (Ramarao, 2007). 

Para describir la operación de filtración granular se debe considerar tanto la fuerza de la 

gravedad como de la presión aplicada al fluido a través del medio filtrante. Sin embargo, 

la interacción del fluido con el medio filtrante presenta un conjunto de fuerzas adicionales 

que deben también tomarse en consideración para elaborar un análisis detallado del 

comportamiento del medio filtrante con el fluido. La fuerza de arrastre, las fuerzas 

Brownianas, y las fuerzas de Van der Waals son ejemplos de lo mencionado 

anteriormente (Messina, Icardi, Marchisio, & Sethi, 2012). Adicional a esto el trasporte 

de las partículas dentro de un medio filtrante puede ser descrito por los siguientes 

mecanismos: difusión, sedimentación, intercepción, impacto inercial, acción 

hidrodinámica y mecanismos de transporte combinados (Maldonado, 2004).  

 

Cabe resaltar que las dimensiones del filtro se obtuvieron del trabajo de Vargas, M., 

Murayama M., et al. (2015). Nanoscale structural / chemical characterization of 

manganese oxide surface layers and nanoparticles, and the associated implications for 

drinking water. En este estudio se analiza el comportamiento de reacciones químicas en 

filtros con lecho empacado esférico con diámetros que varían desde 1 hasta 3 [mm]. Se 

utilizó esferas de 3,5 [mm] de diámetro en el presente proyecto, ya que comercialmente 

es más accesible encontrar esferas de este diámetro en comparación a las utilizadas en el 

trabajo de Vargas, M., Murayama M., et al. Esta elección es primordial para una futura 

construcción del prototipo del filtro.  

 

Para el presente proyecto se estudió computacionalmente un sistema cilíndrico con 

esferas de 3.5 [mm] de diámetro en su interior, con la finalidad de simular un sistema de 

filtrado de agua para la remoción de un contaminante genérico considerando distintos 

tamaños de partícula. Mediante el estudio dinámico del comportamiento de un fluido a 

través del medio filtrante en el modelo propuesto, se determinó el tamaño de partícula del 

contaminante para el cual el filtro funciona de manera más óptima. Para ello se 

establecieron los siguientes objetivos específicos: i) Generar una representación 

tridimensional de un prototipo propuesto mediante el software INVENTOR de 

AutoCAD. ii) Aplicar las ecuaciones de transporte de momento, parámetros, constantes 

y condiciones adecuadas para la simulación del fenómeno de filtración. iii) Emplear el 

módulo Flujo Turbulento k-ω con el fin de resolver las ecuaciones de Navier-Stokes y el 
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módulo Particle Tracing for Fluid Flow para cuantificar la efectividad del filtro en 

función del tamaño de partícula. iv) Construir un mallado de la geometría propuesta para 

emplear las ecuaciones de Navier-Stokes para flujo turbulento. v) Determinar los perfiles 

de velocidad y cambios de presión. vi) Cuantificar tres mecanismos de transporte de 

partículas: difusión, intercepción y sedimentación.  

    

2. Dinámica de Fluidos Computacional (CFD) 

 

La Dinámica de Fluidos Computacional (CFD) es una disciplina que se encarga del 

análisis de sistemas que involucran transporte de fluidos, transferencia de masa, calor y 

fenómenos relacionados, tal como reacciones químicas mediante el uso de modelos 

matemáticos implementados en algoritmos computacionales (Jairo Osorio, 2012). 

Algunos de los paquetes computacionales más conocidos para esta disciplina son: 

COMSOL Multiphysics ®, Fluent y Ansys; los mismo que permiten estudiar de forma 

detallada un sistema y obtener una descripción cercana a su comportamiento real. 

Es importante mencionar que antes de iniciar un estudio es indispensable establecer las 

condiciones del sistema, el tipo de fluido que se está analizando, condiciones de borde, 

material del sistema, geometría, entre otros. Debido a que todos estos factores determinan 

las ecuaciones y modelos matemáticos que se deben utilizar para describir los fenómenos 

del sistema.     

 

3. Modelado de sistemas turbulentos 

 

Para comprender el modelo matemático que se utilizó para simular el comportamiento 

del fluido dentro del sistema. Es preciso comprender la teoría tras el modelado de un 

sistema turbulento. Existen distintos regímenes de fluido, los cuales están relacionados 

estrechamente con el número de Reynolds. La asignación numérica para cada uno de los 

regímenes fue reportada por primera vez en 1883 por Osborne Reynolds  (N. D. E. 

Reynolds, David, & Díaz, 2015), quien estableció la siguiente ecuación para determinar 

el tipo de flujo en base a un número adimensional definido como: 

 

𝑅𝑒 =  
𝜌𝑉𝐿

𝜇
         

(1) 
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donde 

𝜌 = Densidad del fluido [kg/m3] 

𝑉 = Velocidad del fluido [m/s] 

𝐿 = Longitud de la tubería [m] 

𝜇 = Viscosidad dinámica del fluido [Pa s] 

 

Con ello se estableció que un fluido es laminar cuando el valor del número de Reynolds 

es  (Re ≤ 2000) de transición (2000 ≤ Re ≤ 4000) o turbulento (Re ≥ 4000) (N. D. E. 

Reynolds et al., 2015).   

 

 

Figura  2. Ilustración de los regímenes de fluido y las distintas regiones que se forman en el régimen turbulento. 

FUENTE: (Frei, 2017) 

 

Cuando se considera un fluido en estado laminar resulta relativamente sencillo predecir 

el comportamiento del mismo en base a las ecuaciones de Navier-Stokes (M. Sajben, 

1977). Estas ecuaciones gobiernan el movimiento de los fluidos y pueden ser descritas en 

base a la segunda ley de Newton del movimiento de fluidos. 

  

𝜌 (
𝛿𝒖

𝛿𝑡
+ 𝒖 ∙ ∇𝒖) = 

⏟            
1

−∇𝑝⏟ 𝑰
2

+ ∇((𝜇 + 𝜇𝑇)(∇𝒖 + (∇𝒖)
𝑇) −

2

3
𝜇(∇𝒖)𝑰 − 

2

3
𝜌𝑘𝑰)

⏟                              
3

+ 𝐹⏟
4

        
(2) 

 

 

donde 

𝒖 = Vector de velocidad del fluido [m/s] 

𝜌 = Densidad del fluido [kg/m3] 

𝑝 = Presión del fluido [Pa] 

𝜇 = Viscosidad dinámica del fluido [Pa s] 
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𝜇𝑇 = Viscosidad turbulenta [Pa s] 

𝑘 = Energía turbulenta cinética [m2/s2] 

𝑇 = Periodo de tiempo [s]. 

𝑰 = Matriz Identidad 

 

El primer término de la ecuación (2) corresponde a las fuerzas inerciales, el segundo 

término a las fuerzas de presión, el tercero señala las fuerzas viscosas y el cuarto término 

considera las fuerzas externas aplicadas al fluido.   

Cabe resaltar que las ecuaciones de Navier-Stokes siempre son resueltas con la ecuación 

de continuidad, las cuales consideran la conservación de masa: 

𝛿𝜌

𝛿𝑡
+ ∇ (𝜌𝒖) = 0      

(3) 

 

Cuando se trata de un fluido incompresible las ecuaciones (2) y (3) se modifican de la 

siguiente manera: 

 

𝜌 (
𝛿𝒖

𝛿𝑡
+ 𝒖 ∙ ∇𝒖) =  −∇𝑝𝑰 + ∇ ∙ [(𝜇 + 𝜇𝑇)(∇𝒖 + (∇𝒖)

𝑇) − 
2

3
𝜌𝑘𝑰] + 𝐹   

(4) 

 

  

𝜌∇ ∙ (𝒖) = 0          (5) 

 

Obteniendo finalmente la siguiente ecuación: 

 

𝜌 (
𝛿𝒖

𝛿𝑡
) =  −∇𝑝𝑰 + ∇ ∙ [(𝜇 + 𝜇𝑇) − 

2

3
𝜌𝑘𝑰] + 𝐹   

(6) 

 

Las resoluciones de estas ecuaciones permiten obtener los valores de velocidad y presión 

de un fluido en un determinado sistema. A medida que el fluido tiende al régimen 

turbulento; la resolución de las ecuaciones de Navier-Stokes se torna más complicada 

debido a la formación de vórtices y la presencia de fuerzas externas.   

 

Si observamos la Figura 2 es posible visualizar que a medida que el fluido tiende al 

régimen turbulento se presentan pequeños vórtices y la escala de tiempo de las 

oscilaciones se hacen tan pequeñas que no se pueden describir computacionalmente el 

sistema empleando las ecuaciones de Navier-Stokes (Frei, 2017). Para ello se utiliza la 
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formulación RANS (Reynolds-average Navier-Stokes formulation), la cual promedia los 

campos de velocidad y presión en el tiempo (M. Sajben, 1977).  

 

La formulación RANS esta descrita de la siguiente manera: 

 

𝜌 ( (𝑼 ∙ ∇𝑼) + ∇ (𝜇𝑇(∇𝑼+ (∇𝑼)
𝑇)) −

2

3
𝜇𝑇(∇𝑼)𝑰) =  −∇𝑷 + ∇ ∙ (𝜇(∇𝑼 + (∇𝑼)

𝑇) −
2

3
𝜇(∇𝑼)𝐼) + 𝐹        (7) 

 

donde 

𝑼 = Vector de velocidad promedio [m/s] 

𝑃 = Presión promedio [Pa] 

 

La viscosidad turbulenta 𝜇𝑇; se debe a los efectos a pequeña escala de la velocidad los 

cuales no son resueltos por la formulación RANS (T.J. Bogar, 1983). En vista de esto 

existen varios modelos de turbulencia para evaluar el término  𝜇𝑇.  

 

A continuación, se describen algunos de estos modelos: 

 L-VEL and yPlus: Calcula el valor de la viscosidad turbulenta en base a 

expresiones algebraicas para la velocidad local del fluido y distancias cercanas a 

las paredes del sistema. Brinda buenas aproximaciones para flujos dentro de 

geometrías cerradas (flujos internos). 

  Spalart-Allmaras: Desarrollado con fines aerodinámicos, es un modelo estable 

que brinda una buena convergencia de las soluciones. No calcula con precisión 

campos de velocidad que presenten flujo separado, decaimiento de turbulencia y 

flujo cortante (Frei, 2017). 

 k-ɛ: El modelo resuelve ecuaciones algebraicas para dos variables: k, energía 

cinética turbulenta; y ɛ, tasa de disipación turbulenta. Este modelo es utilizado 

para aplicaciones industriales porque presenta una buena convergencia y pocos 

requerimientos de memoria del computador (Frei, 2017). No es preciso para flujos 

que presentan gradientes de presión adversos, flujos con grandes curvaturas y 

flujos jet.  

 k-ω: Similar al modelo k-ɛ, pero resuelve para la variable ω - tasa específica de 

disipación de energía cinética. Es un modelo no linear; y es útil en situaciones 

donde el modelo k-ɛ no es preciso. 



17 

 

 Low Reynolds Number k-ɛ: Resuelve el flujo en cualquier parte del sistema. 

Necesita de un mallado extensivo en toda la geometría, por lo cual requiere de una 

gran cantidad de memoria del computador en donde se lleva a cabo la simulación. 

El modelo calcula fuerzas de arrastre, y pueden ser modelados con gran precisión 

los flujos de calor en comparación al modelo k- ɛ (Frei, 2017).      

 

Para el presente proyecto se empleó el Modelo de Flujo Turbulento k-ω debido a su 

precisión y grado de convergencia para flujos con grandes curvaturas y gradientes de 

presión adversos.  

 

4. Modelo de Flujo Turbulento k-ω (Turbulent Flow, k-ω) 
 

Este modelo define la viscosidad turbulenta de la siguiente manera: 

 

𝜇𝑇 =  𝜌
𝑘

𝜔
      

(8) 

 

donde 

𝑘 = Energía turbulenta cinética [m2/s2] 

𝜔 = Tasa específica de disipación de energía cinética [1/s] 

La energía cinética turbulenta está descrita de la siguiente manera: 

 

𝜌
𝜕𝑘

𝜕𝑡
 + 𝜌(𝒖 ∙  ∇)𝑘 =  𝑃𝑘 − 𝛽0

∗𝜌𝜔𝑘 + ∇  ∙ [(𝜇 + 𝜎𝑘
∗ 𝜇𝑇)∇𝑘]       

(9) 

 

La tasa específica turbulenta se expresa de la siguiente manera: 

 

 𝜌
𝜕𝜔

𝜕𝑡
 + 𝜌(𝒖 ∙  ∇)𝜔 =  𝛼

𝜔

𝑘
𝑃𝑘 − 𝛽0𝜌𝜔

2 + ∇ ∙  [(𝜇 + 𝜎𝜔 𝜇𝑇)∇ω]       
(10) 

 

donde 

𝜌 = Densidad del fluido [kg/m3] 

𝒖 = Velocidad promedio [m/s] 

𝜇 = Viscosidad dinámica del fluido [Pa s] 

𝜇𝑇 = Viscosidad turbulenta [Pa s] 

𝑘 = Energía turbulenta cinética [m2/s2] 
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𝜔 = Tasa específica de disipación de energía cinética [1/s] 

𝛽0
∗, 𝜎𝑘

∗ , 𝜎𝜔 , 𝛼, 𝛽0, 𝐾𝑣, 𝐵 = Parámetros del modelo turbulento  

𝑃𝑘  se define con la siguiente ecuación: 

 

𝑃𝑘 = 𝜇𝑇 [∇𝒖 ∙ (∇𝒖 + (∇𝒖)
𝑇)] −

2

3
 𝜌𝑘 ∇𝐮      

(11) 

 

Resolviendo la ecuación (8) en base a las ecuaciones (9) y (10) es posible obtener el valor 

numérico para la viscosidad turbulenta 𝜇𝑇; expresión que después será reemplaza en la 

ecuación (4). 

La ventaja de este modelo turbulento es que cuantifica de manera más precisa los cambios 

de presión y velocidad los flujos internos, flujos con curvaturas pronunciadas, flujos 

separados, entre otros (Frei, 2017). Por esta razón se escogió este modelo para la 

resolución del flujo a través de nuestro sistema, ya que permitió cuantificar las pérdidas 

de presión y flujos de velocidad en el sistema precisamente. Cabe resaltar que la 

resolución de las ecuaciones (7), (9) y (10) son en base a métodos iterativos, de los cuales 

se hablará más adelante.  

 

5. Modelo Particle Tracing for Fluid Flow en COMSOL Multiphysics ® 

 
El modelo matemático utilizado para cuantificar la eficiencia de filtrado del sistema se 

denomina Particle Tracing for Fluid Flow.  La ventaja que brinda este modelo dentro del 

software COMSOL Multiphysics ® es que permite rastrear la trayectoria de partículas en 

presencia de un campo externo. Para este caso el campo externo es el fluido que atraviesa 

el sistema. 

Por lo tanto, la finalidad de utilizar este modelo radica en el hecho de que permite agregar 

al filtro un número específico de partículas esféricas con masa, radio y densidad. 

Seguidamente para asignarles una velocidad inicial y obtener las trayectorias de las 

partículas a través del sistema. Posterior a esto, se determinará el porcentaje de partículas 

que permanecen dentro del filtro cuando el fluido atraviesa el sistema en base a una 

función de probabilidad. 

 

La ecuación que rige el modelo (momento de una partícula) se deriva de la segunda ley 

de Newton, la cual indica que la fuerza neta sobre una partícula es igual a su tasa de 
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cambio de momento lineal en un intervalo de tiempo (“The Particle Tracing Module 

User’s Guide,” n.d.). La ecuación se presenta a continuación:  

 

𝑚𝑝

𝑑𝑉

𝑑𝑡
= 𝐹𝐷 +𝐹𝑔 +𝐹𝑒𝑥𝑡    

(12) 

 

donde 

𝑚𝑝 = Masa de la partícula [kg] 

𝑉 = Velocidad de la partícula [m/s] 

𝐹𝐷 = Fuerza de arrastre sobre la partícula [N] 

𝐹𝑔 = Fuera de gravedad [N] 

𝐹𝑒𝑥𝑡 = Fuerzas externas actuantes sobre la partícula [N] 

Se define a la fuerza de arrastre con la siguiente ecuación: 

 

𝐹𝐷 = (
1

𝜏𝑝
)𝑚𝑝(𝒖− 𝑽)     

(13) 

 

donde 

𝒖 = Vector de velocidad del fluido [m/s] 

𝑽 = Vector de la velocidad de la partícula [m/s] 

𝜏𝑝 = Velocidad de respuesta de la partícula en el tiempo [s] 

 

𝜏𝑝 = 
𝜌𝑝𝑑𝑝

2

18𝜇
       

(14) 

 

 

𝜌𝑝 = Densidad de la partícula [kg/m3], 𝜌𝑝 = 2200 [kg/m3] 

𝑑𝑝 = Diámetro de la partícula [m]. 𝑑𝑝 = 1x10-6 [m] 

 

En este estudio se varía el diámetro de las partículas considerando que la mayoría de los 

contaminantes del agua residual son partículas sólidas que en gran medida se presentan 

en forma coloidal (Chávez, Alma ; Jiménez, 2000). El tamaño de las partículas 

suspendidas varía de 0,005 hasta 100 [𝜇m].  

 

La fuerza de gravedad se expresa con la siguiente ecuación: 
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𝐹𝑔 = 𝑚𝑝 𝒈(
𝜌𝑝 − 𝜌

𝜌𝑝
)         

(15) 

 

donde 

𝜌𝑝 = Densidad de los alrededores del fluido [kg/m3] 

𝒈 = Vector de la gravedad [m2/s] 

 

En este proyecto únicamente se utilizaron la fuerza de arrastre y de gravedad sobre cada 

una partícula. No se consideró ninguna contribución de fuerzas externas. Por lo tanto, la 

ecuación [11] se reescribe de la siguiente manera: 

 

𝑚𝑝

𝑑𝑉

𝑑𝑡
= 𝐹𝐷 +𝐹𝑔        

(16) 

 

Reemplazando las ecuaciones (13) y (15) en la ecuación (16) se obtiene: 

 

𝑚𝑝

𝑑𝑉

𝑑𝑡
=  (

1

𝜏𝑝
)𝑚𝑝(𝒖− 𝑽)+ 𝑚𝑝 𝒈(

𝜌𝑝 − 𝜌

𝜌𝑝
)      

(17) 

 

La ecuación (17) fue aplicada a cada una de las partículas que se agregaron al sistema. 

Con lo cual se obtuvo las trayectorias de cada partícula en el filtro.   

 

6. Resolución de ecuaciones diferenciales: Método de elementos finitos 
 

La forma para resolver ecuaciones diferenciales de alta complejidad es a través de 

métodos numéricos, los cuales permiten alcanzar resultados aproximados a la solución 

exacta de las ecuaciones diferenciales mediante el uso de algoritmos (Forsythe, 1970). 

Entre los diferentes métodos existentes, el de los elementos finitos (MEF) permite la 

descripción aproximada de un sistema considerando su geometría sobre la cual se definen 

un conjunto de puntos discretos a los cuales se asocian las ecuaciones diferenciales 

(Zienkiewicz, 1981). Entonces, este método se fundamenta en dividir el domino general 

de un cuerpo en un conjunto de subdominios no intersecantes. Cada subdivisión de 

dominio se llama elemento finito, y cada uno tiene una serie de puntos adyacentes 

representativos denominados nodos, los cuales en conjunto dan paso a la formación de 

una malla (Bathe, 2006).  
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Figura  3. Visualización de la malla sobre las esferas de 3.5[mm] de diámetro dentro del filtro de 152.4[mm] de 

largo. La malla está formada por elementos finitos, y cada elemento finito está unido por varios nodos. 

 

En cada nodo se define un conjunto de variables que se han relacionado en base a la 

adyacencia de los puntos nodales. El conjunto de variables definidas en un nodo se 

denomina grados de libertad (Zienkiewicz, 1981) . Se puede establecer una relación entre 

el valor de una variable específica y los nodos; dicha relación es expresada en forma de 

un sistema de ecuaciones lineales que se pueden resolver mediante métodos matriciales 

(Bathe, 2006).  

 

7. Método Iterativo de resolución de ecuaciones diferenciales en 

COMSOL Multiphysics ®  
 

En COMSOL Multiphysics ® existen dos tipos de algoritmos matemáticos para la 

resolución de sistemas de ecuaciones lineales cuando se trabaja con un problema de 

elementos finitos: Método Directo y Método Iterativo, de los cuales se analiza el segunda 

en vista de que se utilizó en el proyecto.  

 

Este método genera una secuencia de soluciones mejoradas para el problema que se desea 

resolver (Amritkar, Sturler, Swirydowicz, Tafti, & Ahuja, 2015). Cuando resolvemos un 

problema iterativamente en COMSOL Multiphysics ® es posible visualizar el error 

estimado de la solución en base al número de iteraciones.  
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Figura  4. Ejemplo de convergencia de la estimación del error vs el número de iteración 

 

La Figura 4 es el gráfico de convergencia de las ecuaciones del modelo del Flujo 

Turbulento k-ω en el sistema de filtrado donde se ha incluido dos gráficas de 

convergencia: Convergencia en velocidad y presión (Paso Segregado 1) y Convergencia 

en viscosidad turbulenta (Paso segregado 2).  

Ambas cantidades tienden a un determinado valor de error (1x10-3) conforme el número 

de iteraciones aumenta. Esta tendencia indica que la función de velocidad, presión y 

viscosidad turbulenta después de un número determinado de iteraciones alcanzan 

convergencia y por lo tanto las ecuaciones características del sistema pueden ser 

consideradas resueltas.  

 

Dentro de los métodos iterativos existen varias técnicas que son empleadas para obtener 

una solución a un determinado sistema de ecuaciones. Una técnica iterativa no es más que 

un algoritmo específico que resuelve un sistema de ecuaciones de una forma en particular. 

En este proyecto se utilizó GMRES, debido a que el sistema de ecuaciones es no lineal. 

  

 

    8. Metodología  
 

El análisis dinámico se llevó a cabo en el paquete computacional COMSOL Multiphysics 

®, en el cual se utilizaron dos modelos matemáticos específicos para la resolución de las 
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ecuaciones que comprenden al sistema de filtrado. El primer modelo permitió la 

obtención de perfiles de velocidad y presión dentro del filtro, Turbulent Flow k-ω, y el 

segundo cuantificó la eficiencia de filtrado del sistema, Particle Tracing for Fluid Flow. 

 

Se divide a la metodología en dos partes fundamentales para la elaboración del proyecto: 

Desarrollo de la geometría del filtro en INVENTOR de AutoCAD y Modelado del sistema 

en COMSOL Multiphysics ®. 

 

8.1 Desarrollo de la geometría de filtro en el software INVENTOR de AutoCAD” 

 

Para elaborar un modelo del sistema, se utilizó el software INVENTOR de AutoCAD. 

Este programa permite al usuario construir de forma sencilla modelos 3D con cualquier 

tipo de geometría. El modelo del filtro consta de las siguientes partes: 

 

 Codo de 90° de ½’’. 

 Retenedor de sólidos de 11 [mm] de largo. 

 Columna de 152.4[mm] de largo y diámetro interno 11[mm]. 

 Empaquetamiento de esferas de 3.5 [mm] de diámetro (200 esferas). 

 Reductor de ½’’ a ¼’’. 

 

Cada parte de sistema fue construida por separado para finalmente ensamblarse como un 

solo conjunto (Figura 5).  
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Figura  5. a) Diseño del codo de 90° de ½”, b) Diseño de la columna de 152.4[mm] de largo y diámetro interno 

11[mm], c) Diseño del reductor de ½” a ¼” 

 

 
 

Figura  6. a) Diseño del empaquetamiento para la columna de 152.4[mm] de largo y diámetro interno 11[mm]. Con 

esferas de 3.5[mm] de diámetro, b) Diseño del ensamble de todas las partes del filtro 
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Una vez obtenido el ensamble final del filtro se importó la geometría desde INVENTOR 

de AutoCAD al software COMSOL Multiphysics ® para llevar a cabo los análisis 

dinámicos del fluido. Con respecto al fluido se seleccionó en COMSOL Multiphysics ® 

el tipo de fluido como agua. El programa COMSOL Multiphysics ® modeló el fluido y 

su comportamiento dentro del filtro en base al módulo de Flujo Turbulento k- ω. 

Considerando que el caudal de entrada del fluido fue de 16[ml/min].  

 

8.2 Modelado del sistema en el software COMSOL Multiphysics ® 
 

Para el desarrollo del análisis del fluido a través del filtro y la cuantificación de la 

eficiencia de filtrado dentro es sistema se llevaron a cabo dos estudios: Flujo Turbulento 

k-ω y Particle Tracing for Fluid Flow.  

 

8.2.1 Estudio de Flujo Turbulento k- ω, para obtención de perfiles de velocidad y 

presión 

 

Para la realización de este estudio se importó la geometría previamente diseñada en 

INVENTOR de AutoCAD al software COMSOL Multiphysics ®. En este software se 

estableció las ecuaciones diferenciales, condiciones iniciales y de borde para desarrollar 

el estudio. Las ecuaciones que rigen al modelo son (4)-(11).  

Se emplearon los siguientes valores para los parámetros el modelo turbulento señalados 

en las ecuaciones (8) y (9): 

 

Tabla 2. Valores para los parámetros del modelo turbulento 

Parámetro Valor 

𝛽0
∗ 9/100 

𝜎𝑘
∗ 1/2 

𝜎𝜔 1/2 

𝛼 13/25 

𝛽0 9/125 

𝐾𝑣 0.41 

𝐵 5.2 

  

Se establecieron como condiciones iniciales las siguientes ecuaciones: 
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𝒖 = − 𝑈0 𝒏     (78) 

 

donde 

𝑈0 = Velocidad de entrada del fluido, 𝑈0 = 0.0021 [m/s] 

𝒏 = Matriz de vectores unitarios  

 

𝑈𝒓𝒆𝒇 = 𝑈0      (19) 

 

𝑘 = (
3

2
 𝑈𝑟𝑒𝑓 𝐼𝑇)

2

   
(20) 

 

donde 

𝐼𝑇 = Intensidad turbulenta 

𝜔 =
𝑘1/2

(𝐵0
∗)1/4 𝐿𝑇

     
(21) 

 

donde 

𝐿𝑇 = Escala de longitud turbulenta [m] 

 

Una condición de borde es una posición en el espacio físico en la cual se puede evaluar 

una ecuación diferencial con el objetivo de obtener una solución única para ese espacio 

en particular.   

Las condiciones de borde utilizadas se denominan funciones de pared, y se presentan a 

continuación: 

 

𝒖 ∙ 𝒏 = 0 (22) 

 

[(𝜇 + 𝜇𝑇)(∇𝒖 + (∇𝒖)
𝑇) − 

2

3
𝜌𝑘𝑰]𝒏 =  −𝜌

𝜇𝑇
𝛿𝑤
+
 𝒖𝑡𝑎𝑛𝑔    

   

(23) 

 

𝒖𝑡𝑎𝑛𝑔 = 𝒖− (𝒖 ∙ 𝒏)𝒏 

        

(24) 

 

∇𝑘 ∙ 𝒏 = 0       (25) 
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𝜔 =  𝜌
𝑘

𝐾𝑣 𝛿𝑤
+ 𝜇
      

(26) 

 

donde 

 𝐾𝑣 = 0.41 

𝛿𝑤
+ = Distancia con respecto a la pared de la geometría [m] 

𝜇 = Viscosidad fluido [Pa s] 

 

A la salida del filtro se utilizan las siguientes condiciones: 

 

𝒖 = 𝑈0 𝒏 (27) 

 

      ∇𝑘 ∙ 𝒏 = 0        (28) 

 

     ∇𝜔 ∙ 𝒏 = 0        (29) 

 

En base a la solución de las ecuaciones (4)-(11), tomando en consideración las 

condiciones iniciales, de borde y a la salida del filtro se obtiene la solución para el Estudio 

de Flujo Turbulento k-ω.  

 

8.2.2 Estudio de Particle Tracing for Fluid Flow, para cuantificación de la eficiencia 

de filtrado 

 
Una vez obtenida la resolución del Estudio de Flujo Turbulento k-ω, se agregó la interface 

para calcular la trayectoria de las partículas dentro del filtro. Para ello se resuelven la 

ecuación (15), considerando como condición inicial a la ecuación (33): 

 

𝒗 =  𝒗0  (30) 

 

donde 

𝒗0 = Velocidad inicial de las partículas [m/s], 𝒗0 = 0.002104 [m/s] 

 

Se utiliza la condición de borde “Rebotar” con lo cual las partículas rebotan al golpear las 

paredes del sistema. Esta condición está definida por la ecuación (31): 
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𝒗 = 𝒗𝑐 − 2(𝒏 ∙ 𝒗𝑐)𝒏  

    

(31) 

 

donde  

𝒗𝑐 = Velocidad de la partícula cuando golpea la pared [m/s] 

 

En base a la resolución de la ecuación (17), tomando en consideración las condiciones 

iniciales y de borde se obtiene la solución para el Estudio de Particle Tracing for Fluid 

Flow. 

 

8.2.3 Cálculo de las medidas de aporte por los mecanismos de transporte: difusión, 

intercepción y sedimentación considerando distinto tamaños de partículas dentro 

del lecho empacado  

 

La medida de aporte analizadas se realizó para los siguientes mecanismos de transporte:  

difusividad, intercepción y sedimentación. Se calculó cada aporte en base a un tamaño de 

partícula específico. El tamaño de partícula varió desde 1[um] hasta 100[um]. Para el 

cálculo de cada medida de aporte se utilizó las ecuaciones (32), (37) y (40), 

respectivamente:  

 

Difusividad 

  

Ƞ𝑫 = 4 𝐴𝑠
1
3⁄  𝑃𝑒−

2
3⁄  (32) 

donde 

𝐴𝑠 = Corrección del Factor de Happel 

𝑃𝑒 = Número de Peclet 

 

El factor de Happel se obtiene de la siguiente ecuación: 

 

𝐴𝑠 =
2(1 − 𝜑5)

2 − 3𝜑 + 3𝜑5 − 2𝜑6
 

(33) 

 

𝜑 = (1 − 𝜀)1/3 (34) 

 

donde 

𝜑 = Porosidad tridimensional 
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𝜀 = Porosidad 

 

El número de Peclet se obtiene de la siguiente ecuación: 

  

𝑃𝑒 =
𝑉𝑎 𝑑𝑐
𝐷∞

 
(35) 

  

𝐷∞ =
𝑘 𝑇

3𝜋 𝑑𝑝 𝜇
 

(36) 

 

donde 

𝑉𝑎 = Velocidad [m/s] 

𝑑𝑐 = Diámetro del colector [m]. En nuestro caso es el diámetro de las esferas del lecho 

empacado 

𝑘 = 1,38x10-23 [J/K] 

𝑇 = Temperatura sistema [K] 

𝑑𝑝 = Diámetro de la partícula [m] 

𝜇 = Viscosidad dinámica del fluido [Pa s] 

 

Intercepción 

Ƞ𝑰 = 𝐴𝑠 𝐿𝑜
1
8⁄  𝑅𝑎15/8  (37) 

 

donde 

𝐴𝑠 = Corrección del Factor de Happel 

𝐿𝑜 = Diferencia entre las fuerzas de London y Vander Waals 

𝑅𝑎 = Relación entre el diámetro del colector y de la partícula 

 

La diferencia entre las fuerzas de London y Vander Waals se calculó con la siguiente 

ecuación: 

𝐿𝑜 =  
4 𝐴

9𝜋 𝜇 𝑑𝑝2 𝑉𝑎
 

(38) 

donde 

𝐴 = 1x10-20 [J] 

𝑉𝑎 = Velocidad [m/s] 

𝑑𝑝 = Diámetro de la partícula [m] 
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𝜇 = Viscosidad dinámica del fluido [Pa s] 

 

La relación entre el diámetro del colector y de la partícula se obtiene de la siguiente 

ecuación:  

𝑅𝑎 =  
𝑑𝑝

𝑑𝑐
 

(39) 

donde 

𝑑𝑝 = Diámetro de la partícula [m] 

𝑑𝑐 = Diámetro del colector [m] 

 

Sedimentación 

Ƞ𝑺 = 0,00338 𝐴𝑠 𝐺𝑅
1,2 𝑅𝑎−0,4 (40) 

 

donde 

𝐴𝑠 = Corrección del Factor de Happel 

𝐺𝑅 = Fuerza de gravedad 

𝑅𝑎 = Relación entre el diámetro del colector y de la partícula 

 

La fuerza de gravedad se calcula con la siguiente fórmula: 

𝐺𝑅 = 
(𝜌𝑠 − 𝜌) 𝑔 𝑑𝑝

2

18 𝜇 𝑉𝑎
 

(41) 

 

donde 

𝑔 = 9,8 [m/s2] 

𝑑𝑝 = Diámetro de la partícula [m] 

𝑉𝑎 = Velocidad [m/s] 

𝜇 = Viscosidad dinámica del fluido [Pa s] 

 

9. Resultados y Discusión 
 

9.1 Estudio de Flujo Turbulento k- ω 
 

9.1.1 Campo de Velocidad  

 

Tras llevar acabo el Estudio de Flujo Turbulento k-ω se obtuvieron los siguientes 

resultados para el campo de velocidad: 
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Figura  7. Corte transversal del campo de velocidad en el filtro en unidades de [m/s] 

 

Es posible visualizar en la Figura 7 el paso del fluido a través del sistema de filtrado. Se 

determinó que la velocidad máxima alcanzada por el fluido en el sistema fue a la salida, 

𝑣𝑚𝑎𝑥= 0.0043 [m/s]. Esto se debió al hecho de que a la salida del filtro no existió cuerpo 

geométrico alguno que impida el flujo del fluido; a diferencia del lecho empacado donde 

se observa una disminución considerable de la velocidad debido a las esferas contenidas 

en dicho espacio. La velocidad mínima registrada fue 𝑣𝑚𝑖𝑛= 3.145x10-7 [m/s]. Existe una 

diferencia considerable entre la velocidad máxima y mínima alcanzada. Dicha diferencia 

se debe a que el valor mínimo de velocidad en el sistema se considera en una región donde 

la velocidad del fluido es casi nula. La razón por la cual en esta zona del filtro se registra 

la menor velocidad se debe a que el fluido no ingresa directamente al lecho empacado, 

sino que se retiene antes de entrar. Tiende a acumularse en la entrada debido a que existe 

un caudal constante.  

Para determinar la presión de operación del sistema se utiliza la ecuación (42):           

 

𝜏 =  
∆𝑃 𝐷

4 𝐿
 

(42) 
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donde 

𝜏 = Presión de operación [Pa] 

 ∆𝑃 = Gradiente de presión en el sistema [Pa] 

D = Diámetro del filtro [m] 

L = Longitud del filtro [m] 

 

Es importante resaltar que el valor del ∆𝑃 de la ecuación (42) fue considerado en base a 

los valores presentados en la Figura 11. Siendo el ∆𝑃 = 2,57 [Pa]. Por lo tanto, se puede 

afirmar que la presión necesaria de operación del sistema es: 

𝜏 = 0,0464 [Pa] 

También se puede calcular la fuerza necesaria de operación dividiendo el valor de presión 

de operación para el área transversal del filtro. En nuestro caos el área transversal es 𝐴 = 

9,503x10-5 [m]. El valor para la fuerza de operación obtenido fue: 

𝐹 =4,407x10-6 [N] 

 

Los perfiles de velocidad en la entrada, lecho empacado y salida del filtro se presentan a 

continuación: 

 

                  Figura  8. Perfil de velocidad a la entrada del filtro (codo de ½”) en base a distintos tiempos de 

simulación 

 

Es posible observar en la Figura 8 la formación de un perfil de velocidad parabólico a 

medida que el tiempo transcurrió. Con lo cual se afirma que en la entrada del filtro el 

fluido no tuvo un comportamiento caótico, más bien se comportó como un fluido en 
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régimen laminar. Lo cual era de esperarse debido a que el número de Reynolds calculado 

para el codo de ½” fue Re = 29.92. La velocidad máxima alcanzada en esta sección del 

sistema fue 𝒗𝒎𝒂𝒙 = 0.0021 [m/s].       

 

 

         Figura  9.  Perfil de velocidad dentro del filtro (lecho empacado) en base a distintos tiempos de simulación 

La Figura 9 presenta la formación del perfil de velocidad del fluido en una zona dentro 

del lecho empacado en distintos intervalos de tiempo. En este caso el fluido tiene un 

comportamiento turbulento debido a que la geometría del empaquetamiento ocasiona que 

la velocidad del fluido aumente o disminuya según la posibilidad que tiene el fluido a 

transitar dentro del lecho empacado. En base a la Figura 9, las paredes del lecho empacado 

son las zonas en donde la velocidad presenta la máxima velocidad (𝒗𝒎𝒂𝒙 = 0.0018 [m/s]), 

debido a que el fluido fluye con mayor facilidad. A diferencia del centro del lecho 

empacado en donde la velocidad máxima alcanzada es 𝒗𝒎𝒂𝒙 = 0.0010 [m/s]. Con lo cual 

se afirma que el fluido tiende a detenerse en el centro del empaquetamiento. Es preciso 

señalar el empacado del lecho fue aleatorio, es decir, la ubicación de las esferas dentro 

del sistema no tuvo un orden específico. Por ende, el perfil de velocidad de la Figura 9 

puede variar con respecto a la zona del empaquetamiento que se considere para realizar 

el perfil.     
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       Figura  10.  Perfil de velocidad a la salida del filtro (reductor de ½” a ¼”) 

 

En el perfil de velocidad a la salida del filtro, ilustrado en la Figura 10, se observa que el 

comportamiento del fluido es laminar. Esto se debe que a la salida no existe geometría 

alguna que modifique el comportamiento del fluido a un régimen turbulento. La velocidad 

máxima alcanzada en esta sección del sistema fue 𝒗𝒎𝒂𝒙 = 0.0039 [m/s]. Este valor de 

velocidad máxima fue el mayor cuantitativamente en comparación con los valores de 

velocidad máxima obtenidos de las Figuras 8 y 9.     

  

9.1.2 Campo de Presión 

 

Los resultados para el campo de presión se presentan en la Figura 11:  
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Figura  11.  Corte transversal del campo de presión en el filtro en unidades de [Pa] 

 

En la Figura 11 es posible observar que a medida que el fluido transita por el filtro la 

presión disminuye. El fluido ingresa al sistema y debido al empaquetamiento la presión 

disminuye al igual que la velocidad del fluido dentro del lecho empacado. Por lo tanto, 

en la entrada del filtro existe la mayor presión (𝑃𝑒𝑛𝑡𝑟𝑎𝑑𝑎 = 2.578[Pa]) y en la salida la 

presión es casi nula (𝑃𝑠𝑎𝑙𝑖𝑑𝑎 = 0.0010[Pa]). La diferencia de presión y la fuerza de 

gravedad actuante en el sistema ocasionan el flujo del fluido.       

 

9.2 Estudio Particle Tracing for Fluid Flow 
 

Tras llevar acabo el Estudio de Particle Tracing for Fluid Flow se obtuvieron los 

resultados presentados en la Tabla 3 para la eficiencia de filtrado del sistema. Cabe 

resaltar que el valor para la eficiencia de filtrado se obtuvo en base a un balance de masa 

del número de partículas en la entrada y salida del filtro. Siendo el número de partículas 

a la salida del filtro dividido para el número total de partículas iniciales la probabilidad 

de transmisión. El porcentaje de retención es la diferencia multiplicada por cien entre el 

valor de probabilidad menos uno.    
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Tabla 3. Valores de la probabilidad de transmisión con respecto al tamaño de partícula 

Tamaño de partícula 

[μm] 

Probabilidad de 

Transmisión 

Porcentaje de Retención 

[%] 

1 0.9490 5.100 

10 0.6603 33.97 

20 0.2977 70.23 

30 0.1740 82.60 

40 0.1007 89.93 

50 0.0697 93.03 

60 0.0043 99.57 

70 0.0043 99.57 

80 0.0043 99.57 

90 0.0043 99.57 

100 0.0043 99.57 

 

En base a los resultados de la Tabla 3 es posible afirmar que conforme el tamaño de 

partícula aumenta la probabilidad de retención se incrementa. Por ende, a mayor tamaño 

de partícula mayor porcentaje de retención de las partículas dentro del sistema. Sin 

embargo, el hecho de que la probabilidad de retención se incremente considerablemente 

indica que el sistema de filtrado se satura, anulando la capacidad de filtración. Por ende, 

el sistema trabajaría óptimamente hasta un máximo tamaño de partícula de 50 [μm] para 

evitar la saturación completa. Los resultados se observan en la Figura 12: 

 

 

 

Figura  12. Gráfica del porcentaje de retención vs tamaño de partícula 
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9.3 Resultados para las medidas de aportes por los mecanismos de transporte: 

difusividad, intercepción y sedimentación de partículas de distinto tamaño dentro 

del lecho empacado 

 

Se obtuvieron los siguientes resultados para los distintos aportes por los mecanismos de 

transporte de las en base a las ecuaciones (35), (40) y (43): 

 

Mecanismo de transporte de partículas por difusión 

 

Se presenta a continuación los valores calculados para el coeficiente de difusividad (𝐷∞), 

número de Peclet (Pe) y medida de aporte por difusión (Ƞ𝐷) de partículas de distinto 

tamaño. 

 
Tabla 4. Valores para las medidas de los aportes por el mecanismo de difusión en base a lo diferentes tamaños de 

partícula 

Tamaño de partícula [μm] 𝑫∞ Pe Ƞ𝑫 

1 4,900E-13 2,007E+07 1,00 

10 4,900E-14 2,007E+08 0,22 

20 2,450E-14 4,015E+08 0,14 

30 1,633E-14 6,022E+08 0,10 

40 1,225E-14 8,029E+08 0,09 

50 9,799E-15 1,004E+09 0,07 

60 8,166E-15 1,204E+09 0,07 

70 6,999E-15 1,405E+09 0,06 

80 6,125E-15 1,606E+09 0,05 

90 5,444E-15 1,807E+09 0,05 

100 4,900E-15 2,007E+09 0,05 

 

 

En base a los resultados obtenidos de la Tabla 4, se observa que conforme el tamaño de 

partícula aumenta el aporte por difusión disminuye. Esto se debe porque a medida que el 

tamaño de partícula se incrementa el sistema tiende a saturarse. Por lo tanto, las partículas 

no se difunden, sino tienden a transportarse por otros mecanismos. La Figura 13 muestra 

la relación entre el aporte por difusión y el tamaño de partícula normalizado. 
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Figura  13. Gráfica de la medida de aporte por difusión vs tamaño de partícula 

 

Mecanismo de transporte de partículas por intercepción 

 

La Tabla 5 presenta los valores calculados para la diferencia entre fuerzas de London y 

Vander Walls (Lo), relación entre el diámetro del colector y el de la partícula (Ra). Así 

como las medidas por aporte del mecanismo de intercepción (Ƞ𝐼). 

 
Tabla 5. Valores para las medidas de los aportes por el mecanismo de intercepción en base a los diferentes tamaños 

de partícula 

Tamaño de partícula [μm] Lo Ra Ƞ𝐼 
1 0,0006 2,857E-04 0,00 

10 5,6504E-06 2,857E-03 0,02 

20 1,4126E-06 5,714E-03 0,07 

30 6,2783E-07 8,571E-03 0,14 

40 3,5315E-07 1,143E-02 0,23 

50 2,2602E-07 1,429E-02 0,32 

60 1,5696E-07 1,714E-02 0,44 

70 1,1532E-07 2,000E-02 0,56 

80 8,8288E-08 2,286E-02 0,70 

90 6,9759E-08 2,571E-02 0,84 

100 5,6504E-08 2,857E-02 1,00 

 

Con respecto a las medidas de aporte por el mecanismo de intercepción se observa en la 

Tabla 5, que conforme el tamaño de partícula se incrementa el valor numérico de este 

mecanismo lo hace también. Por ende, a mayor intercepción de las partículas menor 

porosidad en el sistema. Este mecanismo es el responsable en mayor medida de la 
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saturación del sistema, ya que presenta los valores numéricos más elevados en 

comparación con el resto de las medidas de aportes por mecanismos de transporte 

analizados conforme el tamaño de partícula aumenta. La relación entre la intercepción y 

el tamaño de partícula normalizado se presentan en la Figura 14.  

 

 
Figura  14. Gráfica de la medida de aporte por intercepción vs tamaño de partícula 

 

Mecanismo de transporte de partículas por sedimentación 

 

Se presenta a continuación los valores calculados para la fuerza de gravedad (𝐺𝑅), y 

medidas de aporte por el mecanismo de sedimentación (ȠS) para partículas con distinto 

tamaño. 

 

Tabla 6. Valores para el mecanismo de Sedimentación en base a lo diferentes tamaños de partícula 

Tamaño de partícula [μm] 𝐺𝑅 [N] Ƞ𝐒 
1 6,241E-07 2,512E-06 

10 6,241E-05 1,585E-03 

20 2,496E-04 1,104E-02 

30 5,617E-04 3,435E-02 

40 9,986E-04 7,687E-02 

50 1,560E-03 1,436E-01 

60 2,247E-03 2,392E-01 

70 3,058E-03 3,684E-01 

80 3,994E-03 5,354E-01 

90 5,055E-03 7,445E-01 

100 6,241E-03 1,000 
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Finalmente, en base a la Tabla 6 se afirma que conforme el tamaño de partícula se 

incrementa el aporte por el mecanismo de transporte por sedimentación es más notorio. 

Este aporte más las medidas por intercepción ocasionan en gran parte la saturación del 

sistema conforme el tamaño de partícula se incrementa. La relación entre la medida de 

aporte por sedimentación con respecto al tamaño de partícula normalizado se presenta en 

la Figura 15. 

 

 
Figura  15. Gráfica de la medida de aporte por sedimentación vs tamaño de partícula 

 

10. Conclusiones y recomendaciones 
 

Tras llevar a cabo el proyecto se concluye que el sistema de filtrado tendría un 

funcionamiento óptimo para partículas con un diámetro igual o menor a 50[um], y con un 

porcentaje de retención máximo del 93.03[%]. Si bien a mayor tamaño de partícula el 

porcentaje de retención aumenta hasta 99.57[%] (Tabla 3); el filtro se saturaría 

completamente conforme el tiempo transcurre.  

Los perfiles de velocidad obtenidos en las distintas secciones del filtro indican que tanto 

en la entrada (codo de ½”) como en la salida (reductor ½” a ¼”), el fluido siguió un 

comportamiento laminar. Esto se debe a que el caudal de entrada (16 [ml/min]) fue 

demasiado bajo, ocasionando este comportamiento. Por otra parte, el perfil de velocidad 

resultante de la sección del lecho empacado indica un comportamiento turbulento del 

fluido, debido a que las esferas de 3.5[mm] de diámetro contenidas en esta parte del filtro 

alteran el comportamiento del fluido. Las paredes del lecho empacado fueron las zonas 
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por donde el fluido presentó mayor facilidad para fluir, debido a que las esferas y su 

distribución aleatoria permiten la formación de canales en estas zonas específicamente. 

A diferencia del centro del lecho empacado en donde las esferas se encuentran más 

compactas, dificultando el paso del fluido. 

Se recomienda aumentar el valor del caudal de entrada del filtro para visualizar un 

comportamiento más semejante a la realidad en todo el sistema. También llevar a cabo 

un estudio detallado del mallado en el sistema. Si bien se obtuvieron buenas 

aproximaciones de los perfiles de velocidad, un refinamiento detallado del mallado 

brindaría mejores aproximaciones y mejores perfiles de velocidad.  

Por otra parte, sería de gran interés llevar a cabo una reacción química en el sistema para 

cuantificar la conversión de reactivos a productos y el tiempo de residencia. Y comparar 

estos resultados teóricos con valores empíricos de literatura. Para corroborar la veracidad 

y credibilidad de la simulación con respecto a la realidad. 
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12. Anexos 
 

12.1 Modeling Instruction for Turbulent flow, k-w (spf) 

 

From the File menu, choose New. 

 

NEW 

 

1. In the New window, click Model Wizard. 

 

MODEL WIZARD 

 

1. In the Model Wizard window, click 3D. 

2. In the Select physics tree, select Fluid Flow>Single Phase Flow>Turbulent 

Flow>Turbulent Flow, k-ω (spf).  

3. Click Add. 

4. Click Study. 

5. In the Select study tree, select Present Studies>Time Dependent 

6. Click Done. 

 

GLOBAL DEFINITIONS 

 

Parameters 

 

1. On the Home toolbar, click Parameters. 

2. In the Settings window for Parameters, locate the Parameters section. 

3. In the table, enter the following variable u0 = 0,002104 [m/s] 

 

GEOMETRY I 

 

Geometry I 

 

1. In the Model Builder window, expand the Component I (compI) node and 

click on Geometry I. 

2. In the Settings window for Geometry, locate the Units section. 

3. From the Unit length list, choose [mm]. 

 

Import I 

 

1. On the Geometry toolbar, click Import.  

2. In the Settings window for Import, locate Filename and click Browse button to 

upload the geometry design of the filter from Inventor. 

3. Click the Build selected button.   

 

ADD MATERIAL 

 

Water, liquid (mat1) 

 

1. On the Home toolbar, click Add Material to open the Add Material window. 

2. Go to the Add Material window. 
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3. In the tree, select Built-In>Water, liquid. 

4. Click Add to Selection in the window toolbar. 

5. In the Settings window for Material, locate Geometric Entity Selection 

section. 

6. From Geometric entity level list, choose Domain. 

7. From Selection list, choose Manual. 

8. Select Domains 1,2,3, and 51. 

 

Borosilicate (mat2) 

 

1. On the Home toolbar, click Add Material to open the Add Material window. 

2. Go to the Add Material window. 

3. In the tree, select MEMS>Insulators>Borosilicate. 

4. Click Add to Selection in the window toolbar. 

5. In the Settings window for Material, locate Geometric Entity Selection 

section. 

6. From Geometric entity level list, choose Domain. 

7. From Selection list, choose Manual. 

8. Select all domains, except 1,2,3, and 51. 

 

TURBULENT FLOW, k-ω (spf) 

 

Turbulent Flow, k-ω (spf)  

 

1. In the Model Builder window, expand the Component I (compI) and click on 

Turbulent Flow, k-ω (spf).  
2. In the Settings window for Turbulent Flow, locate the Domain Selection 

section. 

3. Select Domains 1,2,3 and 51. 

 

Inlet I 

 

1. On the Physics toolbar, click Boundaries and choose Inlet. 

2. Select Boundary 507 only. 

3. In the Settings window for Inlet, locate the Velocity section. 

4. In the U0 text field, type u_in. 

 

Outlet I  

 

1. On the Physics toolbar, click Boundaries and choose Outlet. 

2. Select Boundary 140 only. 

 

MESH I 

 

Free Tetrahedral I 

 

1. On the Home toolbar, click Mesh>Free Tetrahedral. 

2. In the Settings window for Free tetrahedral, locate the Domain Selection 

section. 

3. From Geometric entity level list, choose Domain. 
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4. From Selection list, choose Manual. 

5. Select all domains, except 1,2,3, and 51. 

 

Size I 

 

1. In the Model Builder window, under Component I (compI)>Mesh I right click 

on Free Tetrahedral I and choose Size option. 

2. In the Settings window for Size, locate the Domain Selection section. 

3. From Geometric entity level list, choose Domain. 

4. From Selection list, choose Manual. 

5. Select all domains, except 1,2,3, and 51. 

6. In the Settings window for Size, locate the Element Size section. 

7. From Calibrate for list, choose Fluid dynamics. 

8. In Element Size section, next to Predefined choose Finer. 

 

Free Tetrahedral 2 

 

1. On the Home toolbar, click Mesh>Free Tetrahedral. 

2. In the Settings window for Free tetrahedral, locate the Domain Selection 

section. 

3. From Geometric entity level list, choose Domain. 

4. From Selection list, choose Manual. 

5. Select Domains 1,2,3, and 51. 

 

Size I 

 

1. In the Model Builder window, under Component I (compI)>Mesh I right click 

on Free Tetrahedral 2 and choose Size option. 

2. In the Settings window for Size, locate the Domain Selection section. 

3. From Geometric entity level list, choose Domain. 

4. From Selection list, choose Manual. 

5. Select Domains 1,2,3, and 51. 

6. In the Settings window for Size, locate the Element Size section. 

7. From Calibrate for list, choose Fluid dynamics. 

8. In Element Size section, next to Predefined choose Extra fine. 

 

STUDY I 

 

Step I: Time Dependent 

 

1. In the Model Builder window, expand the Study I node, then click Step I: 

Time Dependent. 
2. Locate the Study Settings section. Click Range. 

3. In the Range dialog box, type 0.1 in the Step text field. 

4. In the Stop text field, type 40. 

5. Click Replace. 

6. On the Home toolbar, click Compute. 

 

RESULTS 
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The following steps reproduce Illustration 11, 12, 13, 14 and 15. 

Velocity (spf) 

The following steps reproduce Illustration 11 

 

Slice I 

1. In the Model Builder window, expand the Results>Velocity (spf) node. 

2. In the Settings window for Velocity, locate the Plane data section. 

3. From the Plane list, choose zx Planes. 

4. From the Input method list, choose Number of planes. 

5. From the Plane dialog box, type 1. 

6. Click Plot button. 

 

Flow Line I 

1. On the Velocity (spf) toolbar, click Flow Line. 

2. In the Settings window for Flow line, locate the Position of flow lines section. 

3. From the Positioning list, choose Controlled start point. 

4. From the Input method list, choose Number of points. 

5. From the Points dialog box, type 50. 

6. In the Settings window for Flow line, locate the Coloring and style section. 

7. From the Color list, choose Blue. 

8. Click Plot button. 

 

The following steps reproduce Illustration 15 

 

Pressure (spf) 

1. In the Model Builder window, expand the Results>Pressure (spf) node. 

2. In the Settings window for Pressure, locate the Levels section. 

3. From Total levels dialog box, type 100. 

4. Click Plot button. 

 

The following steps reproduce Illustration 12 

 

Cut Plane I 

 

On the Results toolbar, click Cut Plane. 

 

Data Sets 

 

1. In the Settings window for Cut Plane, locate the Data section. 

2. From the Data set list, choose Study I/Solution 1 (sol 1). 

3. Locate the Plane Data section. From the Plane list, choose zx plane.  

4. From y-coordinate field, type -74. 

5. Click Plot button. 

 

2D Cut Line I 

 

1. On the Results toolbar, click 2D Cut Line. 

2. In the Settings window for 2D Cut line, locate the Data set section. 



49 

 

3. From the Data set list, choose Cut plane 1. 

4. In the Settings window for 2D Cut line, locate the Data on line section. 

5. From the Line input method list, choose Two points. 

6. From Point 1 field, type 272.764 (x-coordinate) and 57.74 (y-coordinate). 

7. From Point 2 field, type 278.76 (x-coordinate) and 57.7518 (y-coordinate). 

 

1D Plot Group 5 

 

9. On the Results toolbar, click 1D Plot Group. 

10. In the Settings window for 1D Plot Group, locate the Data set section. 

11. From the Data set list, choose Study 1/Solution 1 (sol 1). 

12. From the Time selection list, choose All. 

 

Linear Graph 1 

 

1. On the 1D Plot Group toolbar, click Linear Graph. 

2. In the Settings window for Linear Graph, locate the Data set section. 

3. From the Data set list, choose 2D Cut Line 1. 

4. From the Time selection list, choose All. 

5. In the Settings window for Linear Graph, locate the y-axis information section. 

6. From Expression field, type z. 

7. Click Plot button. 

 

The following steps reproduce Illustration 13 

 

2D Cut Line 2 

 

8. On the Results toolbar, click 2D Cut Line. 

9. In the Settings window for 2D Cut line, locate the Data set section. 

10. From the Data set list, choose Cut plane 1. 

11. In the Settings window for 2D Cut line, locate the Data on line section. 

12. From the Line input method list, choose Two points. 

13. From Point 1 field, type 151.975 (x-coordinate) and 44.5009 (y-coordinate). 

14. From Point 2 field, type 159.559 (x-coordinate) and 33.204 (y-coordinate). 

 

Linear Graph 2 

 

8. On the 1D Plot Group toolbar, click Linear Graph. 

9. In the Settings window for Linear Graph, locate the Data set section. 

10. From the Data set list, choose 2D Cut Line 2. 

11. From the Time selection list, choose All. 

12. In the Settings window for Linear Graph, locate the y-axis information section. 

13. From Expression field, type z. 

14. Click Plot button. 

 

The following steps reproduce Illustration 14 

 

2D Cut Line 3 

 

15. On the Results toolbar, click 2D Cut Line. 
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16. In the Settings window for 2D Cut line, locate the Data set section. 

17. From the Data set list, choose Cut plane 1. 

18. In the Settings window for 2D Cut line, locate the Data on line section. 

19. From the Line input method list, choose Two points. 

20. From Point 1 field, type 64.023 (x-coordinate) and 41.3234 (y-coordinate). 

21. From Point 2 field, type 64.074 (x-coordinate) and 36.3823 (y-coordinate). 

 

Linear Graph 3 

 

15. On the 1D Plot Group toolbar, click Linear Graph. 

16. In the Settings window for Linear Graph, locate the Data set section. 

17. From the Data set list, choose 2D Cut Line 3. 

18. From the Time selection list, choose All. 

19. In the Settings window for Linear Graph, locate the y-axis information section. 

20. From Expression field, type z. 

21. Click Plot button. 

 

12.2 Modeling Instruction for Particle Tracing for Fluid Flow (fpt) 
 

ADD PHYSICS 

 

1. On the Home toolbar, clicl Add Physics to open the Add Physics window. 

2. Go to the Add Physics window. 

3. In the Add Physics tree, select Fluid Flow>Particle Tracing>Particle Tracing 

for Fluid Flow (fpt). 
4. Find the Physics interfaces in study subsection. In the table, enter the settings: 

 

 
 

5. Click Add to Component in the window toolbar 

6. On the Home toolbar, click Add Physics to close the Add Physics window. 

 

ADD STUDY 

 

1. On the Home toolbar, click Add Study to open the Add Study window. 

2. Go to the Add Study window. 

3. Find the Studies subsection. In the Select study tree, select Present 

Studies>Time Dependent. 
4. Find the Physics interfaces in study subsection. In the table, enter the following 

settings: 

 
 

5. Click Add Study in the window toolbar. 

6. On the Home toolbar, click Add Study to close the Add Study window. 
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PARTICLE TRACING FOR FLUID FLOW (FPT) 

 

On the Physics toolbar, click Turbulent Flow (spf) and choose Particle Tracing for 

Fluid Flow (fpt). 

 

Particle Tracing for Fluid Flow (fpt) 

 

1. In the Model Builder window, under Componet I (comp I) click Particle 

Tracing for Fluid Flow (fpt). 
2. Select Domains: 1,2,3 and 51. 

3. In the Settings window for Particle tracing for fluid flow, locate the Particle 

Properties section. 

4. From Particle release specification list, choose Specify normal mass flow. 

5. From Wall precision order list, choose 2. 

 

Wall I 

 

1. In the Model Builder window, under Component I (comp I)>Particle Tracing 

for Fluid Flow(fpt) click Wall I. 

2. In the Settings window for Wall, locate the Wall condition section. 

3. From the Wall condition list, choose Bounce. 

 

Particle Properties I 

 

1. In the Model Builder window, under Componet I (comp I)>Particle Tracing 

for Fluid Flow (fpt) click Particle Properties I. 

2. In the Settings window for Particle Properties, locate the Particle Properties 

section. 

3. In the dp text field, type 1E-6 [m]. 

 

Drag Force I 

 

1. On the Physics toolbar, click Domains and choose Drag Force. 

2. Select Domains: 1,2,3 and 51. 

3. In the Settings window for Drag Force, locate the Drag Force section. 

4. From the u list, choose Velocity field (spf). 

5. From the μ list, choose Dynamic viscosity (spf/fp1). 

 

Gravity Force I 

 

1. On the Physics toolbar, click Domains and choose Gravity Force. 

2. Select Domains: 1,2,3 and 51.  

3. In the Settings window for Gravity Force, locate the Gravity Force section. 

4. From the ρ list, choose Density (spf/fp1). 

 

Particle Counter I 

 

1. On the Physics toolbar, click Domains and choose Particle Counter. 

2. Select Domains: 1,2,3 and 51.  
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3. In the Settings window for Particle Counter, locate the Particle Counter 

section. 

4. From the Release feature list, choose Release 1. 

 

Release I 

 

1. On the Physics toolbar, click Domains and choose Release. 

2. Select Domains: 1,2,3 and 51.  

3. In the Settings window for Release, locate the Rate of mass flow section. 

4. In the 𝒎̇ field, type 0.0005867 [mg/s]. 

5. In the Settings window for Release, locate the Initial position section. 

6. From the Initial position list, choose Density. 

7. In the N field, type 3000. 

8. In the ρ field, type 1 

9. From the Release distribution accuracy order list, choose 5 

10. In the Settings window for Release, locate the Initial velocity section. 

11. From the Initial velocity list, choose Expression. 

 

STUDY 2 

 

Step I: Time Dependent 

 

7. In the Model Builder window, expand the Study 2 node, then click Step I: 

Time Dependent. 
8. In the Settings window for Time Dependent, click to expand the Values of 

dependent variables section. 

9. Locate the Values of Dependent Variables section. Find the Values of 

variables not solved for subsection. From the Settings list, choose User 

controlled. 
10. From the Method list, choose Solution. 

11. From the Study list, choose Study I. 

12. Locate the Study Settings section. Click Range. 

13. In the Range dialog box, type 0.1 in the Step text field. 

14. In the Stop text field, type 40. 

15. Click Replace. 

16. On the Home toolbar, click Compute. 

 

RESULTS 

 

The following steps reproduce Table 1 

 

Data Set 

 

1. On the Results toolbar, right click on Data Set>Particle I and choose 

Duplicate.  
2. Right click on Particle II and choose Add Selection. 

3. In the Settings window for Add selection, locate Geometric entity level list and 

choose Domain. 

4. Select Domains: 1,2,3 and 51.   
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Derived Values 

 

1. On the Results toolbar, click on Derived values and choose Global evaluation. 

2. In the Settings window for Global evaluation, locate Data set list and choose 

Particle 2. 
3. In Time selection list, choose Last.  

4. In the Settings window for Global evaluation, locate Expression section. 

5. In the Expression field, type fpt.alpha. 

6. In the Unit field, type 1. 

7. Click Evaluate button. 

 

TABLE 

 

Go to the Table window. 

 

 


